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(Note: Minimum screen resolution for use with this program is 1024 x 768. If you attempt to use the program at 

a lower resolution, the display will not fit on the screen. Higher resolutions will adjust automatically.) 

 

Using QSOnscreen, you can calculate simple or complex areas and lengths from screen images of your 

drawings by tracing around the outline with a mouse in the same way as you would use a digitiser or an old 

style planimeter with hard copy drawings. 

 

Basic use 
 

In its simplest form, just 

left click on the screen 

as many times as you 

like to outline a shape 

then when you have 

outlined the last point, 

right-click to indicate 

you’ve finished. 

 

The right click signals 

to the program that you 

have finished the outline 

and it will then join up 

the last point you 

left-clicked with the 

first to form a 

completed polygon. 

The perimeter, area and 

“length (to last point)” 

are then reported at the 

bottom of the screen. 

 

 

You can re-open a completed polygon to the point where you right clicked to close it by selecting “Edit � 

Re-open Polygon”. This feature will enable you to stop part way through a complex outline and save the file to 

disk to complete at a later time. 

 

The lines must not cross at any point or the resultant area calculated will be incorrect. 

Length calculations are unaffected by lines crossing 

 

You will note that until a drawing is loaded and calibrated, the lengths are in “linear units” and areas in “area 

units”. The “length (to last point)” stated onscreen is the total length from the first point you clicked to the last 

point but does not include the final length required to close the polygon. This would be used if (say) outlining a 

road kerb. In measuring the road kerb, we would only be interested in the length generated and the calculated 

area and perimeter would be disregarded. Consequently, it wouldn’t matter if the drawn lines cross. 

 

From the File Menu at the top, “New” (shortcut key F2) is to start a new outline, “Open Data File” loads a 

previously drawn outline and “Save Data File” is to save your work to disk. Press F2 (New) at any time you are 

drawing a polygon to abort and start again. Alternatively, if you make a mistake and want to go back a step or 

two without starting again then press F4. This is a shortcut key for Edit � Undo 

Edit � Close Polygon (shortcut key F3) will only be available if three points have been selected (left clicked). 

The program will automatically close the polygon following the regular shape of the first three points. 
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 This is more relevant to “Calculix Mode” which is discussed later but is also available in non Calculix mode if 

required. You can highlight a completed polygon by selecting “Shade Polygon” from the File Menu. 

 

Loading a drawing 
Once you have mastered the basic keyboard and mouse movements, it’s time to load a drawing. This is done 

from the File Menu at the top. Select “Open Image File” (shortcut key Ctrl+I) to load a new image. 

 

Images can be any of the usual common raster graphic types (jpg, gif, bmp, tif, pcx, png) but Adobe portable 

document format (pdf) or AutoCad formats (dwg and dwf) are currently not supported. If you have drawings in 

a vector graphic format like pdf you will need to convert them to raster graphic images before they can be used 

with this program. There are any number of converters available to transform your drawings to the desired 

format and to the desired rotation. 

 

Omniformat (http://www.omniformat.com/download.html) is one such free utility which I can recommend to 

convert pdf’s. I usually convert to png or jpg format at 150 dpi resolution from an A1 size pdf or 300 dpi from 

an A3 size pdf. That level of resolution is generally sufficient to zoom into in good detail. With lower resolution 

the program will function quicker but the clarity of image will be poorer. It’s a personal choice trade-off which 

you can experiment with. 

 

After conversion to png or jpg I will rotate and resize the image (if required) using Irfanview 

http://www.irfanview.com Everyone will have their own favourites to do these tasks. Just ensure that you 

maintain the aspect of the image/drawing when converting and don’t do anything like stretching to fit. 

 

If you don’t have drawings available on disk there’s nothing to stop you scanning in your own. An A3 scanner 

would be preferable but I have gotten by with my old A4 scanner on occasions. A good shareware program for 

stitching partial A3/A4 scans together is RasterStitch available at http://www.vextrasoft.com/rasterstitch.htm 

 

There are two image examples included with the QSOnscreen program which you can use to practice with. 

Load the first (car park.jpg) by going through the file menu or pressing Ctrl+I 

 

Once a drawing is 

loaded it must be 

calibrated before it can 

be used. You will note a 

message onscreen saying 

“Not Calibrated” and an 

empty box underneath. 

 

Once you have 

calibrated an image for 

use on your computer, 

you can note the relevant 

multiplier and enter the 

number in this box to 

save having to re-

calibrate every time you 

load a particular image. 

More about this later. 

 

The first step is 

calibration. 
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Calibrating a drawing 
 

By default the program will expect dual calibration for increased accuracy. This can be selected/de-selected 

from the options menu. 

 

First off, click on the “Zoom Window” button and use the mouse to select (by dragging) a part of the drawing 

which contains a known length. If you get it wrong or choose to select a different area just click the “Zoom 

Out” button followed by “Zoom Window” again. 

 

In the car park example you can see that there is a dimension across the road marked in red which is 6m long. 

Zoom in on this area. 

 

When you are happy that the 

correct part of the drawing has 

been zoomed, click on the “Lock 

to Zoom” button.  

 

Next, left click on one side of the 

6m wide road and then on the 

other side. After clicking the first 

point, a line will follow the cursor 

onscreen and change colour when 

you click the second point.   

 

If you hold down the <SHIFT> 

key while drawing the line, this 

will restrict movement so that 

only horizontal or vertical lines 

can be drawn. This can help with 

accuracy when outlining in some 

instances. 

 

After clicking the second point a 

dialogue box will appear. 

 

The default selection “Calibrate 

from known length on image” is 

the one we want. Enter “6” in the 

box provided to tell the program 

that the length we have just 

traced is 6m long. Then press OK 

 

With dual calibration we have to 

repeat the task so again click on 

one side of the road and then the 

other. The dialogue box will 

re-appear. 
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Although the same dialogue box 

appears the options at the top are 

greyed out. This is to ensure that 

you use the same method of 

calibration for the second line as 

you do for the first line. 

 

Enter 6 in the box again and press 

OK. It is not essential to draw the 

same line twice but in practice it 

is the most convenient. 

 

With dual calibration, the end 

point errors (if you are slightly 

out when you click) are averaged. 

 

 

 

 

 

The two lines are also compared with each other and you are then 

notified of the percentage difference between the two. If this 

difference is small (say) less than 0.5% this indicates that the two 

calibration lines are both reasonably accurate and you can proceed. 

 

An option when calibrating, 

particularly if you have scanned 

in your own drawing and want to 

calibrate it based on a reference 

to the hard copy, is to select 

“Calibrate from hard copy scale 

drawing” which asks for the 

length on the drawing and scale 

of the drawing as opposed to the 

actual length on site we used in 

the earlier example. 

 

The program will use the length 

on the drawing and the scale to 

calculate the actual length on 

site. Everything else in 

operational terms is the same 

whichever method of calibration 

calculation you use. 

 

 

The program always asks for calibration in linear metres (m) and consequently always outputs areas in square 

metres (m2) but if you want to analyse small scale digital images you can simply enter the calibration length in 

mm and the returned areas will be in mm2. Whichever units you choose to use the output will always be 

returned to two decimal places which is an old convention in QS dimension measurement. 



QSOnscreen Measurement Utility 

5 of 7 

 

The drawing now reverts back to 

the originally loaded size with a 

message saying “Calibrated …” 

 

The number next to the 

re-calibrate image button (in this 

example “3.9947”) is the 

calibration multiplier. Make a 

note of it so that if you load this 

image again (with this specific 

computer and at this specific 

screen resolution) you can enter 

the number manually in the box 

provided on the initial screen and 

press the “Use” button. Thus, you 

won’t need to calibrate the 

drawing every time you use it. 

 

 

 

 

If you are unhappy with the calibration, you can click on the Re-Calibrate Image button at any convenient time. 

 

Measuring areas and lengths 
 

The procedure for measuring areas and lengths is the same as listed at the beginning of this document in the 

Basic Use section except that first you need to zoom in on the part of the drawing you are concerned with. 

 

  
This zoom is exactly the same as 

described earlier when calibrating 

the drawing. If you get it wrong 

first time, “Zoom out” and 

“Zoom Window” again if need be 

until you are happy with the area 

selected then click on “Lock to 

Zoom” 

 

After clicking on “Lock to 

Zoom” you will see that the 

multiplier number listed onscreen 

changes to the new zoom (1.6312 

in the example below). 
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Having zoomed in, trace around 

the area (or length) you want. All 

as described earlier. 

 

ie. Left click around the edge and 

signal finish with a right click. 

Press F2 to start again. Press F4 

to undo one or more clicks. Hold 

down <SHIFT> to force 

horizontal or vertical lines. “Edit 

� Re-open Polygon” to undo a 

right click closure.  

 

You can see that now the drawing 

is calibrated the resultant 

measurement units are m2 and m. 

You can cut’n’paste the numbers 

from the boxes at the bottom of 

the screen if you wish. 

 

When you are finished with this section of the drawing, save the data to file if desired then click on “Restore 

Loaded Image”. This will revert back to the originally calibrated image allowing you to zoom into a different 

part of the drawing. 

 

When you have finished with a particular drawing, File � “Close Image File” will remove a loaded image and 

return the program back to its initial state. 

 

From the Options Menu, there is scope to change the colours of the tracing lines in the unlikely event that your 

background drawing is the same colour as the lines you are using to outline. Most of the time the default colours 

will be okay. You can also hide/show the trace image using the option on the file menu (shortcut key Ctrl+R). 

 

Pinpoint Zoom 
 

If pinpoint zoom is selected from the options menu, when you left click a point and hold the mouse button 

down, a magnified (4x by default) pop-up window will appear to assist in accurate placement of the point. If 

you wish you can adjust the position of the mouse slightly before releasing the mouse button. Releasing the 

mouse button will set the point. If you are not happy with the positioning you can always go back a step by 

pressing F4. 

 

Pinpoint zoom can be switched off from the options menu and will switch itself off automatically if the image 

you are tracing around is already zoomed in so far that individual pixels can be distinguished on screen or if you 

are forcing horizontal or vertical lines by holding down the <SHIFT> key. 

 

Accuracy 
 

Clearly, the overall accuracy will depend on the care taken in outlining a given area or length. The more points 

used to define an area or length, the better. With sufficient care, accuracy is usually much better than +- 1% 

which compares favourably with most digitisers or old style planimeters. 
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On some equipment, you might notice that the basic grid displayed on screen appears to be more rectangular in 

appearance than square. This is because of the shape of screen pixels. However, it makes no difference to the 

calculations. The images you load and measure onscreen will be “stretched” in exactly the same proportion as 

the lines you trace.  

 

Calculix mode 
 

Although, the ability to calculate areas and lengths is a handy operation in its own right, this software comes 

into its own when used in conjunction with “Calculix” Quantity Surveying Software which can be downloaded 

and used, free of charge, from the E-Quantities website (http://www.e-quantities.com)  

 

Detailed procedures for “Calculix Mode” are described in a separate document on the E-Quantities website 

(http://www.e-quantities.com/download/qsoncalx.pdf) , but in brief, room perimeters are traced onscreen in the 

same way as the car park areas described earlier and the data is exported directly to the native room data file 

format used by Calculix. 

 

Cut and Fill mode 
 

Introduced in version 3 of the program is a facility to place existing and finished ground levels onto the outlined 

areas which can be used to calculate cut and fill areas and volumes. Detailed procedures for “Cut and Fill 

Mode” are described in a separate document which accompanies the program. It is also available on the 

E-Quantities website (http://www.e-quantities.com/download/qsoncfil.pdf) 

 

 

* QSOnscreen now comes with its own printscreen facility operated by pressing Ctrl+P on the keyboard. 

I usually have my default  printer set to pdf file so I can save pdf screenshots showing all the cut and fill 

lines along with the relevant earthworks calculations. 
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